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1. Program Overview 
 

Length Nesting v2.5 is a desktop application designed to help users determine the most 

efficient way to cut a list of finished lengths from available stock materials. It is commonly used 

by steel service centers, manufacturers, and other professionals working with linear materials 

such as beams, bars, and rods. The goal of the program is to reduce waste by identifying cutting 

patterns that result in minimal drop lengths while maintaining a fast and user-friendly 

workflow. 

1.1 Purpose and Function 
Length Nesting assists in generating an optimum—or near optimum—cutting sequence for a 

group of finish lengths based on the stock lengths available. After entering the required 

materials to cut and the stock lengths available to cut from, the program calculates: 

• Gross Length Used – Total stock length required, including allowances and drops 

• Net Length to Cut – Total of all required finished lengths 

• Drop Length – Total remnant material left over after cutting 

A detailed listing of cutting instructions and drop amounts is available for on-screen review or 

can be printed using a standard line printer. 

1.2 Cut Optimization Logic 
The nesting routine built into the program is designed to deliver results quickly while reducing 

waste. In most real-world scenarios, the software produces cutting sequences that yield 

minimal drops. However, due to the complex nature of nesting algorithms, the program does 

not guarantee that every result is the absolute best possible outcome in every situation. For 

advanced or edge cases, manual review or further optimization may still be possible. 

1.3 Material Management by Unit 
The program is structured to process one material description—also referred to as a unit—at a 

time. A unit may represent a specific type of material such as: 

• W 8 x 18 beam 

• L 3 x 3 x 1/4 angle 

• 3/4" round rod 

Each unit can be entered, edited, processed, saved, and printed independently. This allows 

users to work through jobs section by section or manage more complex projects that involve 

multiple types of materials. 
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1.4 Project Workflow Tabs 
Each material unit is managed using four main tabs in the software interface: 

1. General – Used for assigning a description and setting key parameters 

2. To Cut – Where users enter the list of finished lengths needed 

3. Cut From – Where users specify the stock lengths available for cutting 

4. Results – Displays the calculated cutting instructions and summary statistics 

Projects can consist of a single unit or multiple units, depending on the complexity of the job. 

Units can be stored as individual files, allowing for easy retrieval, editing, and processing at any 

time. 

1.5 Enhanced Functionality 
Length Nesting v2.5 also includes the ability to: 

• Import material lists using CSV or KISS file formats 

• Pre-define and reuse standard “To Cut” quantities and sizes 

• Export nested results into a CSV format for use in spreadsheets or other systems 

These features allow users to integrate Length Nesting more efficiently into their broader 

workflow, reduce repetitive data entry, and better manage recurring material lists. 
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2. Terminology Used 
 

This section defines key terms used throughout the Length Nesting program. Understanding 

these terms will help users navigate the interface and interpret nesting results more effectively. 

 

2.1 Length Entry Methods 
Length Nesting supports four different units of measurement for entering and displaying 

material lengths. Each material list must use a single, consistent method. You can switch 

between methods using the General tab. 

• Feet/Inches/Fractions 

Supports lengths from 0-0 1/16 to 999-11 15/16. Entry uses redefined fraction keys. 

(See Section 5: Dimension Entry for input instructions.) 

• Inches/Fractions 

Supports lengths from 1/16\" to 9999 15/16\". Also requires fraction shortcut keys. 

• Decimal Inches 

Supports lengths from .001\" to 9999.999\". Allows precision entry without fractions. 

• Millimeters (mm) 

Supports whole millimeter entries from 1 mm to 9999 mm. Decimal millimeters cannot 

be entered but may display up to two decimal places when converting from other 

formats. 

 

2.2 To Cut List 
The To Cut List contains the finish pieces you want to produce. It supports up to 160 entries, 

with each entry including: 

• Quantity: Up to 9999 pieces 

• Length: Entered using one of the supported length methods 

• Piece ID (optional): Up to 9 characters; can be enabled or disabled using the General 

tab 

    To remove an entry, set its quantity to 0. 
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2.3 Cut From List 
The Cut From List defines the stock lengths you have available for nesting. It supports up to 40 

entries, with each entry including: 

• Quantity: Up to 9999 pieces 

• Length: The full stock length available for cutting 

    To remove an entry, set its quantity to 0. 

 

2.4 Squaring Allowance 
This value defines the material removed from each end of a stock piece before any cutting 

occurs. A squaring cut is typically used to ensure clean, square ends. 

• If the squaring allowance is greater than 0", the program assumes each Cut From piece 

will have a squaring cut on both ends. 

• If the squaring allowance is 0", no end trimming is assumed. 

 

2.5 Kerf Allowance 
The kerf is the width of material removed by the saw blade (or shear) during each cut. This 

allowance is subtracted for every parting cut. 

• Kerf loss is calculated separately from the squaring allowance. 

• Not included in the final drop length reported. 

 

Example: 

With a 1" squaring allowance and a 1/2" kerf allowance: 

• A 20'-0" stock length yields a maximum finish piece of 19'-9" 

→ 20'-0" − 2" squaring − 1" total kerf = 19'-9" 
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Cut From Stock: Squaring and Kerf Allowance Example (20’-0 Stock) 

 

2.6 Cut From Groups 
A Cut From Group is a saved list of commonly used stock lengths and quantities that can be 

quickly loaded into the Cut From list during the nesting process. This feature is designed to 

save time when entering standard materials, particularly for users who frequently work with 

the same stock sizes—such as steel service centers. 

Cut From Groups are not an inventory control system. They simply serve as a convenient way 

to pre-load known stock sizes. 

• Create, edit, or delete groups via Maintenance > Update 'Cut From' Groups 

• You can create unlimited groups 

• For Length Nesting, do not exceed 40 Cut From sizes in a group 

• For Plate Nesting, the limit is 10 Cut From sizes 

• To delete a size from a group, set its quantity to 0 

      Tip: If working from steel service center stock, use a high quantity (e.g., 1000) to reflect abundant 

material. If stock is limited, enter the actual quantity available. 
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3. Program Installation and Activation 
 

3.1 Length Nesting 

Installation Workflow 

 

 

 

 

This section provides instructions for installing 

and activating Length Nesting v2.5 on 

supported Windows operating systems. 

Please read through this section before 

beginning your installation. 

3.2 System Compatibility 

Length Nesting is officially supported on: 

• Windows 11 

• Windows 10 

While the program may also install on earlier 

versions of Windows (XP, Vista, 7, 8.1), we 

cannot guarantee compatibility or provide 

support for those platforms. 

    Not Compatible: Windows 98 and 

Windows 2000 

3.3 After Subscribing – What 

to Expect 

Once your subscription has been processed, 

you will receive two emails: 

1. Welcome Email: Confirms your 

subscription and lets you know the 

activation process is underway. 

2. Setup Email: Includes everything you 

need to get started: 

o Login credentials for license 

management 

o Product download links 

o Installation instructions 

o Activation details including License 

ID and Password 
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    License activation is handled within the software — you do not need to log in to your account to 

activate. 

 

3.4 Installation Requirements 

• Administrator Privileges: 

You must have administrative rights to install the software. After installation, the 

program may be run under a standard user account. 

• Internet Access: 

Required for downloading the installer and activating the license online. 

• Evaluation Period: 

If this is your first time installing Length Nesting, the software will automatically begin a 

30-day evaluation period from the installation date. You can activate your license at 

any time during or after the trial. 

 

3.5 Installation Instructions 

1. Download the Installer 

Use the link provided in your setup email or visit: 

https://romacsystems.com/help-center/ 

Select the Nesting Downloads option and download Version 2.5.n of the Length 

Nesting program. 

2. Locate the Installer File 

The file will be saved in your computer’s Downloads folder unless your browser is 

configured to save elsewhere. 

If you're unsure, check your browser’s Downloads section to locate the file: 

LengthNestingSetup_v2.5.exe 

3. Run the Installer 

Right-click on the installer and choose Run as Administrator to begin the setup 

process. 

4. Complete the Installation Wizard 

Follow the on-screen instructions to accept the license agreement and install the 

software. 

 

https://romacsystems.com/help-center/
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3.6 Default Data File Location 

Upon installation, the program creates a default data file in the following location: 

C:\Romac\NEST25\Nest25data.mdb 

This file stores program data and should not be moved unless you are changing the data 

storage location. 

To change the data location: 

1. Manually create the new destination folder 

2. Move the Nest25data.mdb file into that folder 

3. Open the program and go to: 

Maintenance > Configuration 

4. Update the data path to reflect the new folder location 

    The software will not move or create the folder for you — this must be done manually. 
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3.7 Activation Overview 
 

Once installed, you can activate the software using the information provided in your setup 

email. There are two ways to activate your Length Nesting license, depending on whether 

you're activating immediately upon first launch or converting from an evaluation version. 

3.7.1 Method 1: Activate at First Launch 

If you're opening Length Nesting v2.5 for the first time after installation, you will see an 

activation screen like shown below. 

 

 

 

 

On the welcome screen, choose 

Activate Romac Length Nesting 

 

 

 

 

Enter your License ID and 

Password provided in your setup 

email 

 

 

 

 

After successful validation, a 

confirmation screen will appear 

 

Click Continue to complete the activation 

process and begin using the software
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3.7.2 Method 2: Activate from Within the Program (Post-Evaluation) 

If you previously chose to evaluate the software or your trial has expired, you can activate the 

license from within the program interface. 

1. Launch Length Nesting v2.5 

2. Go to the top menu and click the Maintenance tab 

3. Select Activate License from the dropdown menu 

 

 
 

4. Read the popup notice and select Yes if you agree. 

5. Enter your License ID and Password in the activation dialog box 

 

 
 

6. Follow the prompts to complete the activation online 
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Once activated, the evaluation mode is disabled, and your license is registered to the computer. 

You may log in to your ROMAC customer account separately to: 

• View license status and expiration 

• Update your company information 

• Change your activation password (if needed) 

 

3.8 License Management and Transfers 

3.8.1 Accessing the License Portal 

The License Portal is a dedicated online platform where you can manage your ROMAC product 

licenses. Through the portal, you can: 

• Update Company Information: 

Ensure your contact details are current. 

• Change Passwords: 

Modify your license activation password for security. 

• View License Status: 

Check the validity and expiration dates of your licenses. 

To access the License Portal: 

1. Visit the License Management Page in the Help Center located at: 

 https://romacsystems.com/help-center/ 

2. Click on the Go to License Portal button. 

3. Log In: 

Use your Customer ID and Password provided in your setup email to log in. 
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3.8.2 Requesting a License Transfer 

If you need to transfer your Length Nesting license to a different computer or user: 

1. Submit a Transfer Request: 

Contact ROMAC Systems through the License Transfer Request Form on the License 

Management Page in the Help Center to initiate the transfer process. 

2. Provide Necessary Details: 

Include your current License ID(s), Contact Info, and the reason for the transfer. 

3. Await Confirmation: 

ROMAC Systems will process your request and provide instructions for completing the 

transfer. 

 

By following these guidelines, you can effectively manage your Length Nesting licenses, 

ensuring uninterrupted access and compliance with ROMAC Systems' licensing policies. 
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4. Initial Program Configuration 

Before operating Length Nesting v2.5, it’s important to configure several key settings. These 

ensure that your company information, data storage preferences, measurement units, and 

report formatting are aligned with your workflow. 

All configuration options are found on a single screen: 

  Navigate to: Maintenance > Configuration 

 

 
 

 

Configuration Screen 
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4.1 Enter Your Company Name 

The company name entered here will appear at the top of all printed reports generated by the 

program. 

• Locate the Company Name field 

• Enter your company name exactly as you'd like it to appear 

• This setting can be updated at any time 

 

4.2 Review Data File Locations 

Length Nesting uses two types of data organization: Lists and Projects. Both file paths can be 

customized on the Configuration screen by entering a full path or browsing to a folder. 

4.2.1 Data File Structure and Storage 

Length Nesting v2.5 supports two distinct data models: List-Based Data and Project-Based 

Data. 

 

4.2.1.1 List-Based Data (Manually Entered Material Sections) 

• Lists are created manually within the program 

• Each list is saved as a separate file with a .CL2 extension 

• There is no tracking database used for list-based files 

     Example List File: BeamList01.CL2 

 

4.2.1.2 Project-Based Data (Imported or Grouped Lists) 

• Projects are used when importing lists from CSV or KISS files, or when grouping multiple lists 

• Each project is stored in its own folder 

• Items are saved as .CL2 files and are tracked via a shared database file: 

o Nest25data.mdb — required for program-level and project-level tracking 

   Example Project Folder Contents: 

• Nest25data.mdb 

• Part01.CL2, Part02.CL2, etc. 
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4.2.2 Default Installation Path 

By default, Length Nesting installs and stores its data in: 

C:\Romac\NEST25 

This directory includes the default Nest25data.mdb used to manage project-based data. 

 

4.2.3 Changing the Data File Location 

To relocate your data: 

1. Create the New Folder 

Use File Explorer to manually create the new storage folder 

2. Move Required Files 

o For projects: move the Nest25data.mdb and associated .CL2 files 

o For lists: move any standalone .CL2 files 

3. Update File Paths in Configuration 

In Length Nesting, go to: 

Maintenance > Configuration 

Update the Project Data and List Data fields accordingly 

    Important: Length Nesting does not automatically move or create folders. You must 

complete this process manually before updating the settings. 

 

4.3 Select Default Length Method 

Length Nesting supports four different units for entering and displaying material lengths. Only 

one default method can be selected at a time. You may change the method later on a per-list 

basis if needed. 

Available options: 

• Feet/Inches/Fractions 

• Millimeters 

• Inches/Fractions 

• Inch Decimals 

Choose the format that best matches your workflow or industry standards. 
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4.5 Set Default Print Options 

You can configure which sections of the report will be printed by default. These options can still 

be modified manually each time you print. 

Available default print settings: 

•    Print Nested Results 

•    Print “To Cut” Listing 

•    Print “Not Cut” Listing 

•    Print “Cut From” Listing 

Select or deselect any combination based on your reporting preferences. 

 

4.6 Cut From Groups 

A Cut From Group is a saved list of commonly used stock lengths and quantities that can be 

quickly loaded into the Cut From list during the nesting process. This feature is designed to 

save time when entering standard materials, particularly for users who frequently work with 

the same stock sizes—such as steel service centers. 

 

1. Go to Maintenance > Update ‘Cut From’ Groups 

 

 

      
 

2. Add, edit, or delete groups 
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Cut From Groups are not an inventory control system. They simply serve as a convenient way 

to pre-load known stock sizes. 

• You can create unlimited groups 

• For Length Nesting, do not exceed 40 Cut From sizes in a group 

• For Plate Nesting, the limit is 10 Cut From sizes 

• To delete a size from a group, set its quantity to 0 

      Tip: If working from steel service center stock, use a high quantity (e.g., 1000) to reflect abundant 

material. If stock is limited, enter the actual quantity available. 
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5. Dimension Entry 

Length Nesting v2.5 supports four different length entry methods, each with its own format 

and limitations. Only one method may be used per list, but you can convert between methods 

using the General tab at any time. 

 

5.1 Supported Length Entry Methods 

Method 
Format 

Example 

Value 

Meaning 
Notes 

Feet/Inches/Fractions 12-6K 12'–6 15/16" 
Uses hyphen (-), single quote ('), or period (.) 

between feet and inches 

Inches/Fractions 150K 150 15/16" 
Up to 9999 inches; uses shortcut keys for 

fractional input 

Decimal Inches 12.375 12 3/8" 
Up to 2 digits left and 3 digits right of 

decimal 

Millimeters 3150 3150 mm 
Whole numbers only; no decimal input 

allowed 

     Note: Decimal millimeters are displayed when converting from other methods, but cannot be 

entered directly. 

 

5.2 Length Input Rules 

• All length values must match the currently selected length method 

• You cannot mix formats (e.g., combining decimal inches and fractions in the same list) 

• The cursor is always positioned at the end of the field when editing 

• Character insertion is not allowed within the field (you must backspace to correct) 

• Cut and paste is not supported for dimension fields 

 

5.3 Fraction Shortcut Keys 

When working in Feet/Inches/Fractions or Inches/Fractions modes, you can use fraction 

shortcut keys to quickly enter common fractional values. Each key on your keyboard 

corresponds to a predefined fraction. 
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    Tip: You do not need to enter a space before typing the shortcut key. 

 

5.4 Format Notes by Method 

Feet/Inches/Fractions 

• Separate feet and inches using -, ', or . 

• Example: 12-6K = 12 feet, 6 and 15/16 inches 

• Max Foot Entry: 999 

• Max Inch Entry: 11 

Inches/Fractions 

• Example: 150K = 150 and 15/16 inches 

• Max Entry: 9999 inches 

Decimal Inches 

• Example: 12.375 

• Up to 2 digits before the decimal and 3 digits after 

Millimeters 

• Whole number input only 

• Example: 3150 

• Max Entry: 99999 

• Decimal entry not allowed 
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6. Program Operation 

Length Nesting v2.5 is built around a user-friendly, tab-based interface that guides users 

through the process of entering material data, optimizing nesting results, and generating 

reports. The program supports both manual entry and imported data and is structured to help 

operators achieve accurate, low-waste cutting plans. 

 

6.1 User Interface Overview 

The software interface is divided into four main tabs: 

• General – Configure list properties, select dimension method, and convert formats 

• To Cut – Enter or review the list of finish lengths required 

• Cut From – Enter or select available stock lengths to nest from 

• Results – View optimized nesting results, generate reports, or export data 

Data for both To Cut and Cut From lists is entered in a spreadsheet-style grid. 

Use the arrow keys or Enter to move between fields. Use the Tab key to switch focus between 

tabs and lists. 
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7. Create Your 1st Nesting List Manually 
 

7.1 Navigate to File → New List 

 

 
 

7.2 Enter Project Name and Material Description (ie: W8x18, 

L3x3x3/8, etc.) 
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7.3 General Tab 
 

  
 

7.3.1 Enter Kerf and Squaring Allowance (optional) 

7.3.2 Select whether you want to require To Cut Piece ID or not 

7.3.3 Select desired Length Method 
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7.4 To Cut Tab 

 

 

 

7.4.1 Enter the quantity and lengths of the items you wish to nest.  

7.4.2 Enter the piece ID if you required it in the General Tab screen. 

7.4.3 You can sort the list or clear the list to start over. 
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7.5 Cut From Tab 

 

 
 

7.5.1 Manually enter the quantities and lengths of your stock material in the Cut From 

List table 

7.5.2 Optionally, you may populate the Cut From List from one of the Cut From 

Groups in the list in the box to the right of the Cut From List. Simply select the 

appropriate Cut From Group and click the button below the box to automatically enter it 

into the Cut From List. 
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7.6 Results Tab 

 

 

7.6.1 Click on the Process button 

7.6.2 View the Results output 
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7.6.3 You can select to print the nested results, “To Cut” list, “Not Cut” List, and or “Cut 

From” list depending on your needs. 
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8. Importing Project Data 
 

If you have material lists in KISS or CSV file formats, then importing the material is a more 

efficient way of creating nests. 

 

8.1 Importing Project Data from a KISS File 

 
8.1.1 Navigate to File → Import Project → Import Kiss File 

 

 
 

8.1.2 Browse to the folder on your computer that contains the KISS file you wish to 

import 

 

 

 

8.1.3 Select the KISS file for the project you are working on and click Open 
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8.1.4 Enter the Project Name 

 

 

 

8.1.5 You can click on the Material List tab to see the entire list to be imported 
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8.1.6 Click on Create Project 

 

 
 

8.1.7 You will see a pop-up asking if you want to include items with widths. If the 

material list you imported includes items with widths and lengths (ie: plates), then you 

can create a PL2 file by clicking Yes. PL2 files can be opened by our optional Plate 

Nesting program. Click No to ignore this step and continue on to the Length Nesting. 
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8.1.8 Project Items Screen 

 
The Project Items screen will show all of the imported material. Some KISS files may 

contain items like bolts and studs which are not normally nested. 
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2 dimensional items (ie: plates) may also be included in this list, but will not be nested. If 

you elected to include items with widths in the previous step, the program will 

automatically create a PL2 file which will contain the 2 dimensional items. These PL2 

files can be opened within our optional Plate Nesting program. 
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Select the item you wish to nest from the imported list on the right side of the screen. 

Then click on the Open Selected List to begin the nesting process. 

 

The rest of the steps will be identical to the steps we took when manually creating a 

nest. 
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8.2 General Tab 
 

 

8.2.1 Enter Kerf and Squaring Allowance (optional) 

8.2.2 Select whether you want to require To Cut Piece ID or not 

8.2.3 Select desired Length Method 
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8.3 To Cut Tab 

 

 

8.3.1 Imported data will automatically populate the To Cut List . 

8.3.2 You can sort the list or clear the list to start over. 
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8.4 Cut From Tab 
 

 

 

8.4.1 Manually enter the quantities and lengths of your stock material in the Cut From 

List table 

8.4.2 Optionally, you may populate the Cut From List from one of the Cut From 

Groups in the list in the box to the right of the Cut From List. Simply select the 

appropriate Cut From Group and click the button below the box to automatically enter it 

into the Cut From List. 

 

8.5 Results Tab 

 

 

8.5.1 Click on the Process button 
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8.5.2 View the Results output 
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8.5.3 You can select to print the nested results, “To Cut” list, “Not Cut” List, and or “Cut From” list 

depending on your needs. 
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7. Software License Agreement & Limited 

Warranty 

The ROMAC Length Nesting software and associated documentation are protected by United 

States copyright laws and international treaty provisions. Use of this software is subject to the 

following license agreement and limited warranty. 

 

9.1 License Agreement 

ROMAC Systems grants the purchaser a non-exclusive, paid license to use one copy of the 

software on a single computer for each license purchased and paid for. 

• Ownership: 

Title to the media on which the software is recorded transfers to the purchaser, but 

ownership of the software itself remains with ROMAC Systems. 

• Permitted Use: 

Purchaser may make backup copies of the software for use on the licensed computer, 

provided that all copyright notices are retained. 

• Restrictions: 

Unauthorized duplication, reproduction, or distribution of the software is prohibited. 

Purchaser may not rent, lease, sell, modify, or transfer the license except as explicitly 

permitted by ROMAC Systems. 

 

9.2 Limited Warranty 

ROMAC Systems makes no warranty, expressed or implied, regarding the use or performance 

of this software, except as provided below: 

• ROMAC Systems shall not be liable for any loss of business, profits, or data caused or 

alleged to be caused by the use of this software. 

• ROMAC Systems' total liability shall be limited to: 

o Correction of any defects reported within sixty (60) days of the original 

purchase date, or 

o A full refund of the original purchase price, at ROMAC Systems’ discretion. 
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9.3 Governing Law 

This agreement shall be governed by the laws of the State of Tennessee, United States. 

 

9.4 Terms & Conditions 

For the most current and complete Terms & Conditions related to licensing, usage, and support, 

please refer to our official website: 

   www.RomacSystems.com 

 

 

 

https://www.romacsystems.com/

